Workspace tour

Welcome to Corel DESIGNER®, a comprehensive vector-based drawing application for creating technical graphics.

This tutorial will help you become familiar with the terminology and workspace of Corel DESIGNER.

What you will learn

In this tutorial, you will learn to do the following:
• understand Corel DESIGNER terminology and concepts
• navigate the application window
• identify workspace tools

Understanding the terminology

Before you get started with Corel DESIGNER, make sure that you understand the following terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Element in a drawing, such as an image, a shape, a line, text, a curve, or a symbol</td>
</tr>
<tr>
<td>Drawing</td>
<td>Document created in Corel DESIGNER, such as a technical illustration, wiring diagram, or chart</td>
</tr>
<tr>
<td>Bitmap</td>
<td>Image composed of grids of pixels or dots</td>
</tr>
<tr>
<td>Vector graphic</td>
<td>Image generated from mathematical descriptions that determine the position, length, and direction of the lines drawn</td>
</tr>
<tr>
<td>Docker</td>
<td>Window with controls that are relevant to a specific group of tools or tasks</td>
</tr>
<tr>
<td>Flyout</td>
<td>Button that opens a group of related tools or commands in the toolbox</td>
</tr>
<tr>
<td>Artistic text</td>
<td>Text to which you can apply special effects, such as perspective or drop shadows</td>
</tr>
<tr>
<td>Paragraph text</td>
<td>Text that flows in a text frame and can be edited in large blocks. You can wrap paragraph text around an object, around artistic text, or around a paragraph text frame. You can also apply formatting options to paragraph text.</td>
</tr>
<tr>
<td>Projected drawing</td>
<td>Drawing profile that lets you project objects onto drawing planes and create the illusion of three dimensions</td>
</tr>
</tbody>
</table>
Using the application window

When you start Corel DESIGNER, a drawing window appears in the application window. The rectangle in the center of the drawing window is the drawing page, where you create your drawing. Although more than one drawing window can appear at the same time, you can apply commands to the active drawing window only. The Corel DESIGNER application window is illustrated below. A description of its parts follows.

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title bar</td>
<td>Area that displays the title of an open drawing</td>
</tr>
<tr>
<td>Menu bar</td>
<td>Area containing drop-down menu options</td>
</tr>
<tr>
<td>Toolbox</td>
<td>Floating bar with tools for creating, filling, and modifying objects in the drawing</td>
</tr>
<tr>
<td>Rulers</td>
<td>Horizontal and vertical borders that are used to determine the size and position of objects in a drawing</td>
</tr>
<tr>
<td>Drawing window</td>
<td>Area that is outside the drawing page and bordered by the scroll bars and application controls</td>
</tr>
<tr>
<td>Drawing page</td>
<td>Rectangular area in the drawing window that represents the printable portion of the work area.</td>
</tr>
<tr>
<td>Document palette</td>
<td>A color palette that helps you keep track of the colors that you use in your document and stores them for future use</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Detachable bar that contains shortcuts to commands</td>
</tr>
</tbody>
</table>
### Identifying workspace tools

Application commands are accessible through the menu bar, toolbars, property bar, dockers, and toolbox. The property bar and dockers provide access to commands that correspond to the active tool or current task. The property bar, dockers, toolbars, and toolbox can be opened, closed, and moved around your screen at any time.

### Toolbars

Toolbars consist of buttons that are shortcuts to menu commands. The standard toolbar, which appears by default, consists of commonly used commands. The following table explains the buttons on the standard toolbar.

<table>
<thead>
<tr>
<th>Click this button</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>Start a new drawing</td>
</tr>
<tr>
<td>![File]</td>
<td>Open a drawing</td>
</tr>
<tr>
<td>![Save]</td>
<td>Save a drawing</td>
</tr>
<tr>
<td>![Print]</td>
<td>Print a drawing</td>
</tr>
<tr>
<td>![Cut]</td>
<td>Cut selected objects to the Clipboard</td>
</tr>
<tr>
<td>![Copy]</td>
<td>Copy selected objects to the Clipboard</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Paste the Clipboard contents into a drawing</td>
</tr>
<tr>
<td>![Undo]</td>
<td>Undo an action</td>
</tr>
<tr>
<td>![Redo]</td>
<td>Restore an action that was undone</td>
</tr>
</tbody>
</table>
Corel DESIGNER also has toolbars for specific kinds of tasks. For example, the Text toolbar contains commands that are associated with the Text tool. If you use a toolbar frequently, you can display it in the workspace at all times.

The following table describes toolbars other than the standard toolbar.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom toolbar</td>
<td>Contains controls for zooming in and out of the drawing page. Lets you specify a percentage of the original view, click the Zoom tool, or select a page view.</td>
</tr>
<tr>
<td>Text toolbar</td>
<td>Contains controls for formatting and aligning text</td>
</tr>
<tr>
<td>Layout toolbar</td>
<td>Contains commands related to the layout of your document, including PowerClip frames, text frames, columns, and alignment guides</td>
</tr>
<tr>
<td>Transform toolbar</td>
<td>Contains controls for skewing, rotating, and mirroring objects</td>
</tr>
<tr>
<td>Print merge toolbar</td>
<td>Contains controls for creating, loading, and editing print merge fields, and performing a print merge</td>
</tr>
<tr>
<td>Macros toolbar</td>
<td>Contains controls for editing, testing, and running macros</td>
</tr>
<tr>
<td>Internet toolbar</td>
<td>Contains controls for creating rollovers and publishing to the Internet</td>
</tr>
<tr>
<td>Drawing plane toolbar</td>
<td>Contains controls for choosing a drawing plane and a drawing profile and lets you access the Projected axes docker. This toolbar is displayed by default.</td>
</tr>
<tr>
<td>Parallel drawing toolbar</td>
<td>Contains commands for drawing parallel curves</td>
</tr>
</tbody>
</table>
Property bar

The property bar displays controls that are associated with the active tool or current task. Unlike a toolbar, the property bar has content that changes, depending on what you are doing within the application. For example, when you click the Text tool in the toolbox, the property bar displays only text-related controls. In the following example, the property bar displays text formatting, alignment, and editing tools.

Dockers

Dockers resemble the palettes found in other graphics programs, and they display the same types of controls that are found in a dialog box, such as command buttons, options, and list boxes. Unlike most dialog boxes, dockers can be kept open while you work on a drawing, so you can readily access the controls you need as you experiment with different effects. To access a docker, click the Window menu, and click a docker name.

Unlike most dialog boxes, you can keep dockers open while working on a document, so you can readily access the commands to experiment with different effects. An example is the Property manager docker. When this docker is open, you can click an object in the drawing window and view formatting, dimensions, and other properties of the object.

You can attach (or dock) a docker to either side of the application window, or you can float (or undock) a docker and move it around as you work. You can also collapse dockers to save screen space.

If you open several dockers, they usually appear nested, with only one docker fully displayed. You can quickly display a docker hidden from view by clicking the docker tab.
Left: Docked and nested dockers. Right: Floating docker. To dock a floating docker, click the title bar, and drag until the pointer is at the edge of the drawing window. To close a docker, click the X button in the upper-right corner. To collapse or expand a docker, click the docker’s tab.

Status bar

The status bar displays information about selected objects, such as color profile, color proofing status, fill type, outline, cursor position, and relevant commands.

Color palette

A color palette is a collection of color swatches. You can choose fill and outline colors by using the default color palette, which contains 99 colors from the CMYK color model. The selected fill and outline colors appear in the color swatches on the status bar.

The following table describes how to choose a color from the default color palette.

<table>
<thead>
<tr>
<th>To</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a fill color for a selected object</td>
<td>Click a color swatch.</td>
</tr>
<tr>
<td>Choose an outline color for a selected object</td>
<td>Right-click a color swatch.</td>
</tr>
<tr>
<td>Choose from various shades of a single color</td>
<td>Click and hold a color swatch to display neighboring colors, and click a color.</td>
</tr>
<tr>
<td>View more colors on the default color palette</td>
<td>Click the flyout on the color palette.</td>
</tr>
</tbody>
</table>
To add a 10-percent tint to the color of a selected filled object, click a color swatch while holding down Ctrl.

**Toolbox**

The toolbox contains tools for drawing and editing images. Some of the tools are visible by default, while others are grouped in flyouts. Flyouts open to display a set of related Corel DESIGNER tools. A small flyout arrow in the lower-right corner of a toolbox button indicates a flyout. You can access the tools in a flyout by clicking the flyout arrow. After you open a flyout, you can easily scan the contents of other flyouts by hovering over any of the toolbox buttons which have flyout arrows. Flyouts function like toolbars when you drag them away from the toolbox. This lets you view all the related tools while you work.

In the default workspace, clicking the flyout arrow on the Shape tool opens the Shape edit flyout.

Some tools in the toolbox are not visible by default. You can choose which tools to display in the toolbox.

💡 To toggle between displaying and hiding the toolbox, click **Window > Toolbars > Toolbox**.

To hide or display tools in the toolbox, click the **Quick customize** button [1], and enable or disable the corresponding check boxes.

**Locating tools in the toolbox**

The following illustration shows the other flyouts in the default Corel DESIGNER toolbox and can help you locate tools more easily.
The following table describes the tools in the Corel DESIGNER toolbox.

### Pick tools

- **Pick** tool lets you select, size, skew, and rotate objects.

- **Freehand pick** tool lets you select objects by using a freehand selection marquee.

### Shape tools

- **Shape** tool lets you edit a curve object or text character by manipulating nodes.

- **Free transform** tool lets you transform an object by using the Free rotation, Free angle reflection, Free scale, and Free skew controls on the property bar.

- **Smudge** tool lets you distort a vector object by dragging along its outline.

- **Roughen** tool lets you distort the edge of a vector object by dragging along its outline.

- **Smear** tool lets you shape an object by pulling extensions or making indents along its outline.
The **Twirl** tool lets you create swirl effects by dragging along the edge of objects.

The **Attract** tool lets you shape objects by attracting nodes to the cursor.

The **Repel** tool lets you shape objects by pushing nodes away from the cursor.

---

**Curve tools**

The **2-point line** tool lets you draw a straight two-point line segment.

The **Multi-point line** tool lets you draw lines and curves one segment at a time, in preview mode.

The **Freehand** tool lets you draw single line segments and curves.

The **Bézier** tool lets you draw curves one segment at a time.

The **B-spline** tool lets you draw curved lines by setting control points that shape the curve without breaking it into segments.
The **3-point curve** tool lets you draw a curve by defining the starting point, endpoint, and center point.

The **Pen** tool lets you draw curves in segments and preview each segment as you draw.

The **Smart drawing** tool converts your freehand strokes to basic shapes and smoothed curves.

The **LiveSketch** tool lets you sketch naturally with intelligent stroke adjustment.

### Linear pattern tools

The **Linear pattern brush** tool lets you apply brush strokes to a curve and create sweep arrows and similar objects.

The **Linear pattern sprayer** tool lets you draw chains, hoses, pipes, and similar objects.

The **Linear pattern preset** tool lets you draw curves by using preset strokes.

The **Calligraphic** tool lets you draw lines that vary in thickness according to the direction of the line and the angle of the pen nib.
The **Expression** tool lets you draw lines that vary in response to the pressure, tilt, and bearing of the stylus.

---

**Rectangle tools**

- The **Rectangle** tool lets you draw a rectangle by dragging diagonally.

- The **3-point rectangle** tool lets you draw rectangles at an angle.

- The **Graph paper** tool lets you draw a grid to simulate graph paper.

---

**Center-point polygon tools**

- The **Polygon** tool lets you draw a polygon by dragging from the center to a point (vertex) on the polygon.

- The **Star** tool lets you draw perfect stars.

- The **Complex star** tool lets you draw complex stars that have intersecting sides.
Circle tools

- The **Center-point circle** tool lets you draw a circle by specifying the center point and a point on the circumference.

- The **Center-radius circle** tool lets you draw a circle by specifying a value for the radius and then clicking where you want the center to be.

- The **3-point circle** tool lets you draw a circle by specifying three points on the circumference.

Ellipse tools

- The **Ellipse** tool lets you draw an ellipse by dragging diagonally.

- The **3-point ellipse** tool lets you draw ellipses at an angle.

Dimension tools

- The **Parallel dimension** tool lets you draw slanted dimension lines.

- The **Horizontal or vertical dimension** tool lets you draw horizontal or vertical dimension lines.
The **Angular dimension** tool lets you draw angular dimension lines.

The **Segment dimension** tool lets you display the distance between end nodes in single or multiple segments.

The **Radial dimension** tool lets you display the radius of a circle or circular arc.

The **Diametric dimension** tool lets you display the diameter of a circle or a circular arc.

---

**Callout tools**

The **1-leg callout** tool lets you draw a callout with one leading line.

The **2-leg callout** tool lets you draw a callout with a two-segment leading line.

The **3-leg callout** tool lets you draw a callout with a three-segment leading line.

---

**Connector tools**
The **Straight-line connector** tool lets you draw a straight connector line.

The **Right-angle connector** tool lets you draw a right-angle connector line.

The **Rounded right-angle connector** tool lets you draw a right-angle connector line with curved corners.

The **B-spline connector** tool lets you draw a curved connector line by using control points.

The **Bézier curve connector** tool lets you draw a curved connector line one segment at a time.

The **Edit anchor** tool lets you modify connector line anchor points.

**Projected Shapes tools**

The **Thread** tool lets you draw threaded shapes in projected view.

The **Well** tool lets you draw threaded well shapes in projected view.
The **Cylinder** tool lets you draw cylinders in projected view.

The **Prism** tool lets you draw prism shapes in projected view.

**Table tool**

The **Table** tool lets you draw and edit tables.

**Perfect Shapes™ tools**

The **Basic shapes** tool lets you choose from a full set of shapes, including a hexagram, a smiley, and a right-angle triangle.

The **Arrow shapes** tool lets you draw arrows while choosing the shape, direction, and number of heads.

The **Flowchart shapes** tool lets you draw flowchart symbols. These controls are available on the property bar.

The **Miscellaneous shapes** tool lets you draw ribbon objects and explosion shapes. These controls are available on the property bar.
The **Callout shapes** tool lets you draw callouts and labels. These controls are available on the property bar.

---

**Text tool**

The **Text** tool lets you add text, create a paragraph text frame and type within it, or type text along a path if a curve is selected.

---

**Interactive tools**

The **Extrude** tool lets you apply 3D effects to objects to create the illusion of depth.

The **Blend** tool lets you transform one object into another through a series of intermediate shapes and colors.

The **Transparency** tool lets you apply a transparency to an object to partially reveal image areas underneath.

The **Envelope** tool lets you distort the shape of an object by applying an envelope to it and dragging the nodes of the envelope.

The **Drop shadow** tool lets you create the illusion of lighting in a two-dimensional drawing by adding a shadow to an object. You can adjust properties such as feathering, opacity, edge style, and color.
The **Contour** tool lets you create a series of concentric shapes that radiate into or out of an object.

The **Distort** tool lets you transform objects by applying Push and Pull, Zipper, or Twister effects.

### Deletion tools

The **Virtual segment delete** tool lets you delete portions of objects between intersecting lines.

The **Eraser** tool lets you remove unwanted areas in a drawing.

The **Knife** tool lets you split vector objects, text, and bitmaps along straight, freehand, or Bézier lines.

The **Crop** tool lets you remove the areas outside a selection.

### Interactive fill tools

The **Interactive fill** tool lets you fill an object with a gradient of colors or shades.
The **Smart fill** tool lets you create objects from enclosed areas and then apply a fill to those objects.

The **Mesh fill** tool lets you fill an object by blending multiple colors or shades arranged over a mesh grid.

**Eyedropper tools**

The **Color eyedropper** tool lets you sample a color from an object in the drawing window or on the desktop and apply it to other objects.

The **Attributes eyedropper** tool lets you copy object properties, such as line thickness, size, and effects, from an object in the drawing window and apply them to other objects.

**Zoom tool**

The **Zoom** tool lets you change the magnification level in the drawing window.

**Pan tool**

The **Pan** tool lets you drag hidden areas of a drawing into view without changing the zoom level.
From here...

You can explore Corel DESIGNER on your own, or you can learn more by completing other tutorials.

For more information about the topics and tools discussed in this tutorial, refer to the Help. To access Corel DESIGNER Help, click Help > Product Help.